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Software License Agreement 
NOTICE: THIS IS A CONTRACT. BY INSTALLING AND USING THE SOFTWARE INDCATED BELOW, YOU ARE IMPLICITLY 
ACCEPTING ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT. 

SteamTab® Thermodynamic and Transport Properties of Water and Steam 
This ChemicaLogic Corporation ("ChemicaLogic") License Agreement accompanies the software product identified above and related documentation 
(SOFTWARE). The term SOFTWARE shall also include any upgrades, modified versions or updates of the SOFTWARE licensed to you by 
ChemicaLogic. You must read this Agreement carefully before indicating acceptance at the end of the text of this Agreement. If you do not agree with 
the terms and conditions of this Agreement, decline where instructed during installation, and you will not be able to use the SOFTWARE. 
ChemicaLogic grants to you a nonexclusive license to use the SOFTWARE, provided that you agree to the following:  

USE You (an entity or a person) may use the SOFTWARE either on a stand-alone computer or on a network if you meet the following conditions. 

STAND-ALONE COMPUTER USE You must acquire one copy of the SOFTWARE for each computer on which the SOFTWARE will be installed. 
The primary user of the computer may also use the SOFTWARE on a home and/or laptop computer, provided the SOFTWARE is used on only one 
computer at a time. 

SHARED NETWORK USE You may use the SOFTWARE on a network provided you have purchased SOFTWARE equal to the maximum number 
of copies in use at any time. The SOFTWARE is "in use" on a computer when it is resident in memory or when executable and other files are installed 
on the hard drive or other storage device. Software which is stored on a server and not resident in memory on that machine is not considered "in use". 

UPGRADES If the SOFTWARE is an upgrade, you are authorized to use the SOFTWARE only if you are an authorized user of a qualifying product 
as determined by ChemicaLogic. The upgrade SOFTWARE replaces the qualifying product. 

RESTRICTIONS You may not alter, reverse engineer, decompile, or disassemble the SOFTWARE. You may not loan, rent, lease, or license the 
SOFTWARE or any copy. However, you may transfer the SOFTWARE on a permanent basis provided you transfer the SOFTWARE including the 
most recent update and all prior versions, this SOFTWARE Agreement, and all documentation and media, and you do not retain any copies. 

COPYRIGHT The SOFTWARE is owned by ChemicaLogic Corporation, and its structure, organization and code are the valuable trade secrets of 
ChemicaLogic. The SOFTWARE is also protected by United States Copyright Law and International Treaty provisions. You agree not to modify, 
adapt, translate, reverse engineer, decompile, disassemble or otherwise attempt to discover the source code of the SOFTWARE. You may use 
trademarks only to identify printed output produced by the SOFTWARE, in accordance with accepted trademark practice, including identification of 
trademark owner's name. Such use of any trademark does not give you any rights of ownership in that trademark. Except as stated above, this 
Agreement does not grant you any intellectual property rights in the SOFTWARE. 

TRANSFER You may not rent, lease, or sub-license the SOFTWARE. You may, however, transfer all your rights to use the SOFTWARE to another 
person or entity, provided that you transfer this Agreement with the SOFTWARE. 

LIMITED WARRANTY For ninety (90) days from your date of purchase, ChemicaLogic warrants that the magnetic media and the user 
documentation (if any) are free from defects in material and workmanship. ChemicaLogic will, at its option, either refund the amount you paid or 
provide you with corrected items at no charge provided that the defective item(s) is (are) returned to ChemicaLogic within ninety (90) days from the 
date of purchase. Except as specifically provided herein, ChemicaLogic makes no warranty, representation, promise, or guarantee, either express or 
implied, statutory or otherwise, with respect to the SOFTWARE, including but not limited to implied warranties of merchantability, fitness for a 
particular purpose and noninfringement. ChemicaLogic is not responsible for, and does not make any representation, warranty, or condition 
concerning product, media, software, or documentation not manufactured or supplied by ChemicaLogic, such as third parties’ programs that are 
designed to use or include the SOFTWARE. 

LIMITATION OF LIABILITY Because software is inherently complex and may not be completely free of errors, you are advised to verify your work 
and to make backup copies. In no event will ChemicaLogic be liable for any damages whatsoever (including, without limitation, damages for loss of 
business profits, business interruption, loss of business information, or other pecuniary loss) arising out of the use of or inability to use the software, 
user documentation, or related technical support, even if ChemicaLogic has been advised of the possibility of such damages. In no case shall 
ChemicaLogic’ liability exceed the amount paid by you for the SOFTWARE. Because some states do not allow the exclusion or limitation of liability 
for consequential or incidental damages, the above limitation may not apply to you. 

GOVERNING LAW AND GENERAL PROVISIONS This Agreement will be governed by the laws of the Commonwealth of Massachusetts U.S.A., 
excluding the application of its conflicts of law rules. This Agreement will not be governed by the United Nations Convention on Contracts for the 
International Sale of Goods, the application of which is expressly excluded.  If any part of this Agreement is found void and unenforceable, it will not 
affect the validity of the balance of the Agreement, which shall remain valid and enforceable according to its terms. You agree that the SOFTWARE 
will not be shipped, transferred or exported into any country or used in any manner prohibited by the United States Export Administration Act or any 
other export laws, restrictions or regulations.  This Agreement shall automatically terminate upon failure by you to comply with its terms. This 
Agreement may only be modified in writing signed by an authorized officer of ChemicaLogic Corporation. 

U.S. GOVERNMENT RESTRICTED RIGHTS The SOFTWARE and/or user documentation are provided with RESTRICTED AND LIMITED 
RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical 
Data and Computer SOFTWARE clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer SOFTWARE - 
Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer/contractor is ChemicaLogic Corporation, 99 South Bedford Street, Suite 207, 
Burlington MA 01803, USA. 

 
SteamTab® is Copyright © 1995-2010 by ChemicaLogic Corporation. 
SteamTab® is a registered trademark of ChemicaLogic Corporation. 
ChemicaLogic™ is a trademark of ChemicaLogic Corporation. 
All other trademarks and copyrights are hereby acknowledged. 
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Introduction to SteamTab® 
Whatever creativity is, it is in part a solution to a problem. 

– Brian Aldiss (b. 1925), 
Bury My Heart at W. H. Smith’s, “Apéritif” (1990). 

Overview and Features 
Designers of steam processing systems and equipment use a variety of 
conventional methods to look up steam properties for engineering 
calculation, including printed steam tables in different units, stand-alone 
steam property software, proprietary design software, general-purpose 
process simulators and long-hand calculations from fundamental equations. 
Lookup from printed steam tables remains the most frequently used method 
for daily use of steam properties. The interpolation of property values 
between fixed state points is a tedious, boring and prone-to-error exercise 
that has plagued many generations of engineers. 

SteamTab, designed as an add-in package to popular spreadsheet 
applications, allows users the convenient access, without leaving the 
spreadsheet computation environment, to a variety of steam property values. 
SteamTab contains a comprehensive set of thermodynamic and transport 
properties applicable over a wide range of conditions, with selected derivative 
and dimensionless properties. 

SteamTab uses fundamental equations to calculate all steam properties with 
no interpolation or curve fits to raw steam data. SteamTab uses formulations 
that are approved the International Association of the Properties of Water 
and Steam (IAPWS) in 1995 for general and scientific use. This formulation 
is thermodynamically rigorous, accurate, and applicable over wider range of 
conditions. The formulations used in SteamTab are given in the following 
reference: 

Chapter 

1 
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Reference 

Release on the IAPWS Formulation 1995 for the Thermodynamic 
Properties of Ordinary Water Substance for General and Scientific Use, 
The International Association for the Properties of Water and 
Steam, Frederica, Denmark, Sept. 1996. 

The scientific formulation is valid in the entire stable fluid region of water 
from the melting pressure curve starting at 251.165 K to 1273 K at pressures 
up to 1,000 MPa. The formulation can also be extrapolated to pressures up to 
about 100 GPa and temperatures up to 5000 K. 

SteamTab imposes the following temperature and pressure restrictions: 

 Pressure (P, bar):  0  P  100,000 

 Temperature (T, K): 190  T   5000 
 

Note 

SteamTab does not include properties for ice. 

SteamTab is designed as a low-cost, personal productivity-enhancement tool, 
for steam property users in the scientific, engineering, plant operation and 
educational communities.  

SteamTab contains the following features: 

 Easy access to a comprehensive set of thermodynamic and transport steam 
properties from the spreadsheet’s Tools menu 

 Direct “live” links to variable steam conditions by cell reference 

 Choice of Metric/SI or English units 

 Direct calculation of steam outlet conditions for isentropic, isenthalpic, 
constant internal energy or constant volume process 

 SteamTab functions for saturated vapor-liquid, superheated, subcooled, 
and constant steam properties 

 Generation of your own steam property diagrams using the spreadsheet’s 
charting capability 

 Export of steam property values to other applications – limited only by the 
spreadsheet’s file transfer capability 
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 Examples for Expander, Compressor, Pressure Letdown, Relative 
Humidity, etc. 

 

What’s New in Version 4.0 
SteamTab Version 4.0 offers a number of enhancements: 

 SteamTab V4.0 supports Excel versions 2003, 2007 and 2010 running on 
Windows 7, Windows Vista and Windows XP. 

 Supports both 32-bit and 64-bit Excel 2010. 

 Includes automatic installation (and uninstalling) on the supported 
platforms. 

 Fully compatible with all previous versions of SteamTab. 

 The ability to use a numeric property code as well as a mnemonic string 
(the string version is case insensitive). For example, to calculate the enthalpy 
of steam you can use either 8 or “H”. 

 Added two new properties: the isentropic exponent and latent heat of 
vaporization.  

Technical Support and Contact Information 
ChemicaLogic offers free technical support with the purchase of SteamTab. 
If you have any problems during installation or use of SteamTab, please 
contact us at one of the addresses listed below. 

Before requesting support, it would save both your time and our time if you 
could first do the following: 

 Make sure you have read any relevant portions of the manual  

 Isolate the problem to a small test case 

 Have the version number of your copy of SteamTab ready 

 Have the version number of the spreadsheet application and the operating 
system on which it is installed ready 

 
You can contact us via any of the following paths: 
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By Telephone: 781.425.6738 (9 AM to 5 PM, EST) 

By Fax: 781.425.6741 

By Email: clc.support@chemicalogic.com 

By Web: http://www.chemicalogic.com 

By Mail: ChemicaLogic Corporation 
99 South Bedford Street, Suite 207 
Burlington, Massachusetts 01803 
USA 

 
 
 
 

Car·not, Nicolas Léonard Sadi 
Car·not (kär-no¹), Nicolas Léonard Sadi 
1796-1832 
French physicist and engineer who founded the science of thermodynamics. 
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Getting Started 
The reality is that zero defects in products plus zero pollution plus zero risk on the job is equivalent 

to maximum growth of government plus zero economic growth plus runaway inflation. 
– Dixie Lee Ray (1924–94), U.S. Democratic politician, government official. 

“Scientists and Engineers for Secure Energy,” speech, 1980. 
Quoted in: Esther Stineman, American Political Women (1980). 

Minimum System Requirements 
You should not encounter any hardware or software problems in using 
SteamTab on any hardware that has one of the following spreadsheet 
applications pre-installed: 

 Microsoft Excel 2003 or later running on Windows XP or later (32-bit and 
64-bit operating systems are both supported). 

 

Installation 
SteamTab contains an automatic installation program that will install the add-
in within Excel as well as certain example files, document files and the online 
help file.  

To install SteamTab, simply click on the file SETUP-STEAMTAB.EXE and 
follow the instructions on the screen. 

Note 

Before installing SteamTab on your machine, please make sure 
that Excel is not running. 

Chapter 

2 
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Once installation is complete you can access SteamTab from Excel. If you 
need to access the User’s Guide and other documents at are installed, go to 
Window’s Start menu, click on Programs and you should see a folder called 
ChemicaLogic SteamTab as shown below: 

Figure 1: ChemicaLogic SteamTab on Window's Start Menu 

 

Using SteamTab 
The following sections describe how to access and use the various features of 
SteamTab. 

Where is SteamTab? 
As an add-in package to your spreadsheet application, SteamTab quietly 
becomes a part of your spreadsheet. You only see it when you need to use it. 
Just to make sure that SteamTab is available, 

1. Start your spreadsheet application (if you have not already started it) 

2. Excel 2003 Users: Click on the Tools menu. You should see a SteamTab 
pop-up menu somewhere near the bottom of the Tools menu 
Excel 2007 or 2010 Users: Click on the Add-ins ribbon and you will see 
the SteamTab menu. 

3. Expand the SteamTab pop-up menu by clicking on it 

4. The following figures show what you should see 
 

A pop-up menu (which is 
also known as a drop-down 
menu) is a special menu item 
that displays a sublist of 
menu items when it is 
selected. 
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Figure 2: Access to SteamTab in Excel 2003 

 

Figure 3: Access to SteamTab in Excel 2007 or Excel 2010 

 

SteamTab Menu 
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The SteamTab pop-up menu contains the following menu items: 

1. Saturated 
Selecting this menu item brings up the saturated steam properties dialog 
box which helps you obtain saturated vapor or liquid steam properties, or 
two-phase steam properties. 

2. Superheated/Subcooled 
The menu item displays the dialog box for obtaining supercritical or 
subcooled steam properties. This dialog box is also used for constant 
property processes, such as, isenthalpic, isentropic, constant volume, etc. 
SteamTab uses a highly efficient iterative search algorithm to quickly 
calculate all constant-process properties. 

3. Constant Properties 
Selecting this menu item brings up the constant properties dialog box 
which you can use to select the required constant steam property. 

4. Options 
This menu item allows you to select the units and other configuration 
options. You can also change the units and model formulation from any 
of the SteamTab dialog-boxes. 

5. Help 
Provides you with easy access to online help. 

6. About SteamTab 
Gives you information regarding the version of SteamTab installed on 
your machine. 

 
The following sections describe how to use the various capabilities of 
SteamTab. 

Setting Steam Property Options 
The options dialog box helps you in setting up the units to base your 
property calculations. All of the SteamTab dialog-boxes use the same options 
that you specify from the option dialog box. 

You can access the SteamTab options from either the SteamTab pop-up 
menu or from any of the other SteamTab dialog boxes. 

Use the following steps to set the SteamTab options (see Figure 4 for an 
illustration of the SteamTab options dialog box): 

1. Select units 
Select the Metric radio button if you want properties in Metric/SI units or 
select the English radio button for properties English units. 

If you are using the 
Worksheet functions directly 
in you spreadsheet, then you 
do not have to set the 
options. The options dialog 
is only used by the 
SteamTab dialog boxes. 

See Table 1 on page 31 for a 
listing of steam properties 
and their Metric/SI and 
English units 
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2. Select comment option 
Check the comments box if you want SteamTab to place a comment 
regarding the property calculated and the units in the output cell. 

3. Click OK 
Click on the OK button to accept the changes. After you have clicked OK, 
all of the SteamTab dialog-boxes will use the specified units options. 

 

Note 

If you typically work with only one set of options, you need to 
only specify them once. SteamTab will remember the options 
even in subsequent sessions. 

 
Figure 4: Steam Property Options Dialog 

 

 

Using the Saturated Steam Properties Dialog Box 
The saturated steam properties dialog box helps you in calculating saturated 
vapor or liquid steam properties at either specified temperature or specified 
pressure. 

This dialog box automatically creates a call (with all the correct arguments) to 
the appropriate SteamTab function based on the input parameters you 
supply. 

Use the following steps to calculate a saturated steam property (see Figure 5 
for an illustration of the saturated steam properties dialog box): 

1. Select Options 
Click on the Options button to bring up the options dialog-box from 
where you can select the units, as described in the previous section. If 
you previously selected the units, you can skip this step. 

See the Chapter: Function 
Reference on page 29 for a 
description of SteamTab 
functions 

Use this group to 
select the units. 
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2. Select independent variable 
Choose either Temperature or Pressure as the independent variable (the 
variable you wish to specify) by clicking on the appropriate radio button. 

3. Provide a value for the independent variable 
Type in a number for the independent variable in the Value edit box. 
Alternatively, you can type in or select a cell reference that contains a 
value for the specified independent variable. 

4. Select phase 
Select either Vapor or Liquid for saturated properties. For two-phase 
properties, select Quality and specify the steam quality as a value between 
0 and 1. 

5. Select steam property required 
Using the drop-down combo-box, select the steam property you want. 
Use the mouse or the cursor keys to scroll through the list of available 
steam properties until you come to the one you desire. 

6. Provide an output cell reference 
Notice that SteamTab has already filled this in with the currently selected 
cell reference. If this is not where you want the results to go, select or 
type in a different cell reference. 

7. Click OK 
SteamTab will calculate the requested steam property and place it in the 
specified output cell as a formula. 

 

Note 

The specified independent variable must be greater or equal to 
the triple point and less than or equal to the critical point of 
steam. If the specified independent variable is outside these 
bounds, the SteamTab function returns the #VALUE! error in 
Excel versions or the ERR error in Lotus versions. 

If you want a different saturated steam property, simply repeat the above 
steps. Alternatively, you could copy the cell containing the saturated steam 
property function and paste it in the location you want. You can then use the 
saturated dialog box to change the output steam property. 

Depending on your choice 
of units and independent 
variable, the value text will 
show you the units in which 
the value is required 

Tip: Click on a cell where 
you want the results before 
opening the saturated dialog 
box. SteamTab will 
automatically fill in the 
Output cell reference 

You can determine the triple 
point and the critical point 
of steam by using the 
Constant steam properties 
dialog box. See page 15. 

If you activate the saturated 
dialog box on a cell that 
already contains a saturated 
SteamTab function, then 
SteamTab will automatically 
initialize the dialog box with 
the correct values. 
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Figure 5: Saturated Steam Properties Dialog  

 

Using the Superheated/Subcooled Steam Properties Dialog 
Box 
The superheated/subcooled dialog box helps you in calculating supercritical 
or subcooled steam properties. You also use this dialog box to model 
constant property processes, such as, isenthalpic, isentropic, constant volume, 
etc. 

Using this dialog box automatically creates a call to the appropriate SteamTab 
function based on the input parameters you supply. 

The following steps show you how to use this dialog box (see Figure 6 for an 
illustration of the superheated/subcooled dialog box): 

1. Select Options 
Click on the Options button to bring up the options dialog-box from 
where you can select the units, as described in the previous section. If 
you previously selected the units, you can skip this step. 

2. Select independent variables 
Unlike saturated properties, calculating superheated or subcooled 
properties requires two independent variables. SteamTab gives you 9 
combinations of independent variables that you can choose from: 
Temperature and any one of Pressure, Volume, Enthalpy, Entropy, or 
Internal energy 
or 
Pressure and any one of Volume, Enthalpy, Entropy, or Internal energy 

a. Select the first independent variable 
Use the drop down list to select either Temperature or Pressure 
as the first independent variable 

See the Chapter: Function 
Reference on page 29 for a 
description of SteamTab 
functions 

Click here to drop 
down the list box and 
to select the desired 
output steam property 
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b. Select the second independent variable 
Use the drop down list box to select the second independent 
variable. The choices available will depend on what you chose as 
the first independent variable. 

3. Provide values for the independent variables 
Type a number in each of the edit boxes next to the independent variable 
selections. Alternatively, you can type in or select a cell reference that 
contains a value for the specified independent variables. 

4. Select steam property required 
Using the drop-down combo-box, select the steam property you want. 
Use the mouse or the cursor keys to scroll through the list of available 
steam properties until you come to the one you desire. 

5. Provide an output cell reference 
Notice that SteamTab has already filled this in with the currently selected 
cell reference. If this is not where you want the results to go, select or 
type in a different cell reference. 

6. Click OK 
SteamTab will calculate the requested steam property and place it in the 
specified output cell as a formula. 

 
If you want a different superheated or subcooled steam property, simply 
repeat the above steps. Alternatively, you could copy the cell containing the 
superheated/subcooled steam property function and paste it in the location 
you want. You can then use the superheated/subcooled dialog box to change 
the output steam property. 

Figure 6: Superheated/Subcooled Dialog Box 

 

 

Depending on your choice 
of units and independent 
variables, the drop-down list 
box will show you the units 
in which the values are 
required 

Tip: Click on a cell where 
you want the results before 
opening this dialog box. 
SteamTab will automatically 
fill in the Output cell 
reference 

If you activate the 
superheated /subcooled 
dialog box on a cell that 
already contains a SteamTab 
function, then SteamTab will 
automatically initialize the 
dialog box with the correct 
values. 

First Independent 
Variable 

Second Independent 
Variable 

Click here to drop 
down the list box and 
to select the desired 
output steam property 
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Using the Constant Steam Properties Dialog Box 
The constant steam properties dialog box gives you access to fundamental 
steam properties, such as, molecular weight, critical properties, and triple 
point properties. 

The following steps illustrate how to use this dialog box (see the figure below 
for an illustration of this dialog box): 

1. Select Options 
Click on the Options button to bring up the options dialog-box from 
where you can select the units, as described in the previous section. If 
you previously selected the units, you can skip this step. 

2. Select constant steam property required 
Using the drop-down combo-box, select the constant steam property 
you want. Use the mouse or the cursor keys to scroll through the list of 
available steam properties until you come to the one you desire. 

1. Provide an output cell reference 
Notice that SteamTab has already filled this in with the currently selected 
cell reference. If this is not where you want the results to go, select or 
type in a different cell reference. 

2. Click OK 
SteamTab will calculate the requested steam property and place it in the 
specified output cell as a formula. 

 
If you want a different constant steam property, simply repeat the above 
steps. Alternatively, you could copy the cell containing the constant steam 
property function and paste it in the location you want. You can then use the 
constant properties dialog box to change the output steam property. 

Figure 7: Constant Property Dialog Box 

  

 

Tip: Click on a cell where 
you want the results before 
opening this dialog box. 
SteamTab will automatically 
fill in the Output cell 
reference 

If you activate the constant 
property dialog box on a cell 
that already contains a 
constant property SteamTab 
function, then SteamTab will 
automatically initialize the 
dialog box with the correct 
values. 

Click here to drop 
down the list box and 
to select the desired 
output steam property 
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Using Excel’s Function Wizard 
If you know the SteamTab function that you want to use, you can use Excel’s 
function wizard to generate the function call. SteamTab installs all of the 
functions in a category called ChemicaLogic SteamTab as shown below: 

Figure 8: ChemicaLogic SteamTab functions in Excel’s Function Wizard 

 

Selecting the STTP function to shows the function wizard: 

Figure 9: Excel’s Function Wizard for SteamTab Function 

 

If you need help on the function arguments or need to lookup the property 
codes click on the “Help on this function” located on the lower left corner of 
the function wizard. 
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Using SteamTab in Excel’s Visual Basic for Applications 
(VBA) 
You can also use the SteamTab functions in you own macros or functions in 
Excel’s VBA. But before you use the SteamTab functions, you need to 
establish a reference to the add-in from the VBA editor. 

To establish a reference to the SteamTab add-in, start the VBA editor in 
Excel 2003 from the Tools, Macro, Start Visual Basic Editor (or press the 
Alt+F11 keys) or in Excel 2007/2010 from the Developer tab select Visual 
Basic (if you do not see the Developer tab, please refer to this document on 
how to show the Developer tab: http://msdn.microsoft.com/en-
us/library/bb608625.aspx). The Visual Basic editor comes up and from the 
Tools menu Select References and place a check mark next to SteamTab and 
select OK: 

Figure 10: Excel VBA Reference to SteamTab 

 

Once a reference to SteamTab is established you can use the SteamTab 
functions in VBA just as you would any other function, as shown below: 
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Tips and Tricks 
Below is a list of tips that users like you have contributed to help the 
SteamTab user community gain the best possible benefit of using SteamTab 
in a spreadsheet-computing environment. 

We encourage you to submit your tips and tricks to us for inclusion in future 
releases and upgrades. See page 5 for information on how to contact us. 

Tips and tricks to help you become more productive (in no particular order): 

 You may notice a slight delay the first time you use SteamTab. This is 
normal, because the spreadsheet application loads the full SteamTab 
package only when you first use it. This helps conserve memory. 

 You do not have to remember the calling sequence of SteamTab 
functions. Use the SteamTab dialog boxes to generate the correct function 
with the right arguments. 

 Click on the cell where you want the results before opening any of the 
SteamTab dialog boxes. SteamTab will automatically fill in the Output cell 
reference for you. 
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Uninstalling SteamTab 
To uninstall SteamTab, from Window’s Start menu, select Programs, 
ChemicaLogic SteamTab and then select Uninstall ChemicaLogic SteamTab. 
This will completely uninstall SteamTab from your computer. 

You can also uninstall SteamTab from the Control Panel, Add or Remove 
Programs (or Programs and Features in Windows 7) and selecting 
ChemicaLogic SteamTab version 2.0 to uninstall. 
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Joule, James Prescott  
Joule (j¡l, joul), James Prescott 
1818-1889 
British physicist who established the mechanical theory of heat and discovered the first 
law of thermodynamics.



CHEMICALOGIC 

SteamTab V4.0  21 

Tutorial 
sty·mie 

To thwart; stump: a problem in thermodynamics that stymied half the class. 
– The American Heritage Dictionary of the English Language, Third Edition, 1996. 

Introduction 
The SteamTab package you purchased contains several examples and 
templates that you can use in your work. The examples included in the 
SteamTab package illustrate the following concepts: 

 Steam Quality 

 Constant-temperature process 

 Constant-pressure process 

 Constant-volume process 

 Constant-entropy process 

 Constant-internal energy process 

 Irreversible adiabatic expansion 

 Irreversible adiabatic compression 

 Moisture content in air and dew point calculations 

 Relative humidity 

 Charting of steam properties 
 
The following sections give you step-by-step instructions on how to solve 
two steam-related problems using the power of SteamTab: 

1. Calculating the enthalpy of vaporization, and 

2. Constant property process 
 

Chapter 

3 
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Example 1: Enthalpy of Vaporization 
This rather simple example will illustrate how to use SteamTab to obtain the 
enthalpy of vaporization of steam. Note that the enthalpy of vaporization is 
not one of the properties that is automatically calculated by SteamTab. 
(Note: SteamTab V4.0 now includes this property). However, it is nearly 
effortless, given the ease-of-use of SteamTab in a spreadsheet-computing 
environment. 

Calculate the enthalpy of vaporization of water at temperatures of 225°C and 
231.3°C. 

The enthalpy of vaporization of water is defined as the difference between 
the enthalpies of the vapor and the liquid: 

 

Therefore, all that we need to do is use SteamTab to get the saturated vapor 
and liquid enthalpies at the specified temperature and take the difference of 
the two values to get the enthalpy of vaporization. 

If you have access to printed steam tables, looking up the enthalpy of 
vaporization at a particular temperature is very easy, especially if you do not 
have to interpolate between the tabulated temperatures. For example, you 
could easily look up the enthalpy of vaporization at 225°C since most printed 
steam tables are tabulated at increments of 5°C and some even at 1°C 
increments. However, you would have to interpolate to get the enthalpy of 
vaporization at a temperature of 231.3°C. This process becomes tedious if 
you have several such points to compute or if you need to interpolate several 
different properties. 

Using the power of SteamTab and the ease-of-use of spreadsheets, this 
process becomes nearly effortless. The solution to this problem is show in 
Figure 11 below. 

Solution: 

Problem Statement: 
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Figure 11: Tutorial Example 1 

A B C D E
1 Specified Temperature C 225 231.3
2 Vapor Enthalpy kJ/kg 2802.148 2803.015
3 Liquid Enthalpy kJ/kg 966.796 996.3022
4 Enthalpy of Vaporization kJ/kg 1835.352 1806.713
5
6  

The first step in solving a problem in a spreadsheet is to layout the problem 
definition. As shown in the figure above, the known and computed variable 
names are documented in Column A. Column B contains the units in which 
the properties are computed. Column C contains the specified and computed 
properties at the first temperature and column D contains the same at the 
other temperature. 

Using SteamTab, obtain the saturated vapor and liquid enthalpies at 225°C, 
shown in cells C2 and C3. In cell C4 take the difference between C2 and C3 
to get the enthalpy of vaporization at 225°C. Then simply copy cells C1 
through C4 and paste it in cells D1 through D4. Change the temperature in 
cell D1 to 231.3 and instantly you have the solution to the second part of the 
problem. 

The step-by-step instructions for this example are given below. 

1. Layout the problem definition 
It is good practice to first lay out the problem definition. Follow these 
steps: 

a. In cell A1 type Specified Temperature 

b. In cell B1 type C (for the units) 

c. In cell C1 type 225 

d. In cell A2 type Vapor Enthalpy 

e. In cell B2 type kJ/kg (the units in which SteamTab is to return the 
enthalpy) 

f. In cell A3 type Liquid Enthalpy 

g. In cell A4 type Enthalpy of Vaporization 

h. Copy the contents of cell B2 to cell B3 and B4 

i. Expand the width of column A so that you can see all of its 
contents 

2. Set the steam property options 
Since we will be using the SteamTab dialogs to obtain properties, we will 
first the steam property options to use the metric/SI units. 

Step-by-step 
Instructions: 

See Table 1 on page 19 for a 
listing of steam properties 
and their Metric/SI and 
English units 
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a. From the SteamTab pop-up menu select Options 

b. Click on the Metric/SI radio buttons 

c. Click OK 

2. Use SteamTab to get the vapor enthalpy 
In this step you will use SteamTab to get the vapor enthalpy at a 
temperature of 225°C. 

a. Click on cell C2 to make it the active cell 

b. From the Tools menu pop-up the SteamTab menu and select 
Saturated 

c. In the saturated steam properties dialog box, select Temperature 
as the independent variable. Type C1 in the value edit box. Select 
Vapor as the phase. Use the drop-down list box and locate 
Enthalpy as the required steam property. Note that the Output 
Cell is already filled in with C2. Click OK. 

d. The cell C2 should now contain the value 2802.148. Notice that 
cell C2 actually contains a formula which looks like the following: 
For Excel users: =STTSAT(C2,1, 8,0) 
For Lotus 1-2-3 users: @STTSAT(C2,1,8,0) 

3. Use SteamTab to get the liquid enthalpy 
Use the following steps to get the enthalpy of liquid at 225°C. 

a. Copy the contents of cell C2 to cell C3 

b. Make sure that cell C3 is the active cell 

c. From the Tools menu pop-up the SteamTab menu and select 
Saturated 

d. Notice how SteamTab fills-in all of the right values in the dialog-
box. Select Liquid as the phase and click OK. 

e. The cell C3 should contain the value 966.796, which is the 
specific enthalpy of liquid at 225°C. 

4. Calculate the enthalpy of vaporization 
In cell C4 type the formula: C2-C3 and press Enter. You now have the 
answer: 1835.352 kJ/kg. 

5. Extend the result to 231.3°C 
Copy the cells C1 through C4 to cells D1 through D4. Then change the 
value in D1 to 231.3. The numbers is D2, D3, and D4 change 
automatically to their proper values. 

 
If you have been working along, Figure 11 on page 23 shows what your 
spreadsheet should look like. 

Excel users should first 
check on the cell check-box 
next to the value edit box 
before typing in C1. 

You may notice a slight 
delay the first time you use 
SteamTab. This is normal, 
because the spreadsheet 
application loads the full 
SteamTab package only 
when you first use it. This 
helps conserve memory. 
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Example 2: Constant Property Process 
A steam line is connected to an evacuated well-insulated tank via a valve. The 
line pressure is 120 psia and temperature is 800°F. If the valve is opened and 
the steam is allowed to expand into the tank, what is the final temperature in 
the tank? Assume that the steam line is connected to an inexhaustible source 
of steam at the other end.  

Based on the laws of thermodynamics, since no heat is added or removed 
from the system the only work done by the steam in expanding into the tank 
is to change the internal energy of the steam in the tank. In other words, the 
final internal energy in the tank must equal the initial enthalpy of steam in the 
line. Also, the final pressure in the tank must be equal to the pressure of 
steam in the line:  

 

where U is internal energy and H is the enthalpy. The solution to this 
problem is shown in Figure 12. 

The temperature and pressure in the line are specified to be 800°F and 120 
psia. Since the line temperature is greater than the critical temperature of 
steam (705.16°F) the steam is not saturated. Therefore, we use the 
superheated/subcooled SteamTab functions to compute the thermodynamic 
properties of the steam in the line. 

The final conditions in the tank are thus determined: the final pressure in the 
tank is 120 psia and the internal energy is equal to the enthalpy of steam in 
the line. Given these two variables, the rest of the thermodynamic properties 
of steam can easily be computed. SteamTab contains 9 combinations of 
independent variables you can specify, and one of them is pressure (P) and 
internal energy (U). 

Figure 12: Tutorial Example 2 

A B C D E
1 Line Tank
2 Initial (1) Final (2)
3 Pressure (P) psia 120.00 120.00 P 2  = P 1

4 Temperature (T) °F 800.00 1137.92 Answer
5 Enthalpy (H ) Btu/lb 1428.97 1604.45
6 Internal Energy (U ) Btu/lb 1291.41 1428.97 U 2  = H 1

7  

Using a strategy similar to the one in tutorial example 1, we first design and 
layout the problem definition. The known and computed variable names are 

Problem Statement: 

Solution: 

Solution Strategy: 

This example is included in 
your SteamTab package. 
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documented in Column A. Column B contains the units in which the 
properties are computed. Column C contains the line conditions and column 
D the tank conditions. 

Cells C3 and C4 contain the specified line pressure and temperature, 
respectively. Cell D3 simply refers to the value in cell C3, since the final 
pressure is the same as the line pressure. Using SteamTab’s 
superheated/subcooled dialog box and using temperature and pressure as the 
independent variables, we compute the enthalpy and internal energy shown 
in cells C5 and C6. We then refer the contents of cell D6 to the value in cell 
C5, since the final internal energy is the same as the initial enthalpy. Again 
using SteamTab’s superheated/subcooled dialog box with pressure and 
internal energy as the independent variables, we obtain the final 
thermodynamic properties including the final temperature of 1137.92°F. 

The step-by-step instructions are left as an exercise for the user. You should 
follow the general solution strategy described above and re-create this 
example on your own. You can use the example included in your SteamTab 
package as a guide. 

Templates and Examples 
The SteamTab package you purchased contains several examples and 
templates that you can use in your work. Based on your version of SteamTab 
for a particular spreadsheet application, these templates and examples are 
installed and used differently. This is described below. 

SteamTab for Excel 2007/2010 
If you used the automatic installation program, the templates and examples 
are installed in My Templates directory within a sub-directory called 
ChemicaLogic. You can access these templates from within Excel, by 
performing these steps: 

1. Start Excel 

2. From the File menu select New… 

3. Select My Templates to see the templates and examples (Shown in Figure 
13 below) 

4. Select any one of the shown templates to create a working copy of the 
template 

 
An example of how to use the Compressor template is illustrated below. 

Step-by-step 
Instructions: 
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Figure 13: SteamTab Templates for Excel 2007/2010 
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Figure 14: SteamTab Compressor Template Example 

 

 
 

Nernst, Walther Hermann  
Nernst (nèrnst), Walther Hermann 
1864-1941 
German physicist and chemist. He won a 1920 Nobel Prize for his work in 
thermochemistry, particularly his proposal of the third law of thermodynamics (1906) 

Click on the drop-
down list box to 
select the units you 
want to work on. The 
units column will then 
change automatically. 

Enter the problem 
specification in the 
shaded area (the un-
shaded cells are 
protected). After you 
have entered each of 
the 5 values, the 
answer will 
automatically appear. 

Click on the drop-
down list box to 
select the model 
formulation you want 
to work on.  

Click here to display 
or erase the sample 
data shown. 
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Function Reference 
My spelling is Wobbly. It’s good spelling but it Wobbles, and the letters get in the wrong places. 

– A. A. Milne (1882–1958) 
Winnie-the-Pooh, ch. 6 (1926). 

Overview 
The SteamTab add-in package is based on a set of 19 core functions that 
together calculate over 30 thermodynamic and transport properties of steam. 
You can use these functions directly in your spreadsheet or you can use 
SteamTab’s easy-to-use dialog boxes to automatically generate the 
appropriate function call with the correct arguments. 

SteamTab functions are divided into three categories: 

1. Functions for saturated vapor, liquid or two-phase properties 
(2 functions) 
These two functions calculate saturated vapor, liquid and two-phase 
properties from the triple point up to the critical point. You can choose 
either temperature or pressure as the independent variable. 

2. Functions for superheated vapor or subcooled liquid properties 
(9 functions) 
The functions in this category provide you with a rich set of tools for 
conducting several constant-property processes. Depending on the 
choice of independent variables, you can model isentropic, isenthalpic, 
constant volume, or constant internal energy processes.  

3. Functions for constant steam properties 
(8 functions) 
The 8 functions in this category give you access to fundamental steam 
properties that are not functions of temperature or pressure, such as, 
molecular weight, critical properties, and triple point properties. 

 

Chapter 

4 
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Note 

All SteamTab functions begin with the prefix ST. 

Table 1: Overview of SteamTab Functions 

Function Calculates Calling Sequence 

Saturated vapor, liquid or two-phase functions 

STPSAT at specified pressure STPSAT(pressure, quality, code, units) 

STTSAT at specified temperature STTSAT(temperature, quality, code, units) 

Superheated or subcooled functions 

STTP at specified temperature and pressure (T-P) STTP(temperature, pressure, code, units) 

STTV at specified temperature and volume (T-V) STTV(temperature, volume, code, units) 

STTH at specified temperature and enthalpy (T-H) STTH(temperature, enthalpy, code, units) 

STTS at specified temperature and entropy (T-S) STTS(temperature, entropy, code, units) 

STTU at specified temperature and internal energy (T-U) STTU(temperature, internal_energy, code, units) 

STPV at specified pressure and volume (P-V) STPV(pressure, volume, code, units) 

STPH at specified pressure and enthalpy (P-H) STPH(pressure, enthalpy, code, units) 

STPS at specified pressure and entropy (P-S) STPS(pressure, entropy, code, units) 

STPU at specified pressure and internal energy (P-U) STPU(pressure, internal_energy, code, units) 

Constant properties functions 

STMW Molecular weight STMW(units) 

STTC Critical temperature STTC(units) 

STPC Critical pressure STPC(units) 

STVC Critical specific volume STVC(units) 

STRC Critical specific density STRC(units) 

STZC Critical compressibility factor STZC(units) 

STTPT Triple point temperature STTPT(units) 

STTPP Triple point pressure STTPP(units) 

 
In Microsoft Excel units is an optional argument. You need not specify units, 
in which case all requested properties are returned in Metric/SI units, that is, 
the default value is 0. For steam properties in English units, set units to 1.  

The argument quality is used to specify the saturated steam quality (vapor 
fraction) or to specify the two-phase steam quality. Use a value of 1 for 
saturated vapor, 0 for saturated liquid and between 0 and 1 for two-phase. 
The SteamTab functions also return quality as a calculated property. If the 
quality cannot be determined, then a value of -1 is returned. If the phase is 
superheated vapor, then a quality of -2 is returned, and if the phase is 
subcooled liquid a quality of -3 is returned. 
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The argument code, is an integer or string argument (the string is case 
insensitive) that specifies the type of steam property requested. Valid values of 
code and the units in which they are returned are shown in the table below. 

Table 2: Property Codes for Thermodynamic and Transport Properties of Steam 

Code Steam Property Metric/SI Units English Units 

0 T Temperature, T  °C °F 

1 P Pressure, P  bar psia 

2 V Volume, V  m3/kg ft3/lb 

3 D Density,   kg/m3 lb/ft3 

4 Z Compressibility factor, Z  dimensionless dimensionless 

5 A Helmoltz free energy, A  kJ/kg Btu/lb 

6 S Entropy, S  kJ/(kg·°C) Btu/(lb·°F) 

7 U Internal energy, U  kJ/kg Btu/lb 

8 H Enthalpy, H  kJ/kg Btu/lb 

9 G Gibbs free energy, G  kJ/kg Btu/lb 

10 CV Heat capacity at constant volume, vC  kJ/(kg·°C) Btu/(lb·°F) 

11 CP Heat capacity at constant pressure, pC  kJ/(kg·°C) Btu/(lb·°F) 

12 W Speed of sound, v  m/s ft/s 

13 ALPHA Coefficient of thermal expansion,  PTV    1/°C 1/°F 

14 KAPPA Isothermal compressibility,  TPV    1/bar 1/psia 

15 DPDT dpdt,  VTP   bar/°C psia/°F 

16 DVDT dvdt,  PTV   m3/(kg·°C) ft3/(lb·°F) 

17 DVDP dvdp,  TPV   m3/(kg·bar) ft3/(lb·psi) 

18 MU Viscosity (dynamic),   Pa·s lb/(ft·hr) 

19 KT Thermal conductivity, K  W/(m·°C) Btu/(hr·ft·°F) 

20 ST Surface tension,   N/m N/m 

21 PR Prandtl number, PrN  dimensionless dimensionless 

22 DC Static dielectric constant dimensionless dimensionless 

23 IJT Isothermal Joule-Thomson coefficient kJ/(kg·bar) Btu/(lb·psia) 

24 JT Joule-Thomson coefficient °C/bar °F/psia 

25 Q Quality (vapor mass fraction) dimensionless dimensionless 

26 GAMMA Isentropic exponent,  SVPPV  //  dimensionless dimensionless 

27 HV Latent heat of vaporization kJ/kg Btu/lb 

  

Note 

By definition, the thermodynamic Reference State of steam is 
the liquid at the triple point (0.01°C), at which the internal 
energy and entropy are set to zero. 
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Functions for Saturated Steam Properties 
The functions for saturated steam properties calculate vapor, liquid or two-
phase properties at either specified pressure or specified temperature. The 
applicable range of these functions is from the triple point up to the critical 
point. 

Depending on your choice of independent variable, the two functions you 
can choose are: 

Independent Variable Use Function 

Pressure STPSAT 

Temperature STTSAT 

These functions are described in detail below. 

STPSAT 
Calculates the saturated vapor or liquid property at the specified pressure 

Syntax 
STPSAT(pressure, quality, property_code, units) 

Arguments 
pressure is the pressure at which the saturated steam property is 

required. See the Remarks section for acceptable pressure 
units. 

quality is 1 for vapor phase properties, 0 for liquid phase properties 
and between 0 and 1 for two-phase. 

property_code is an integer property code that specifies the type of property 
required. See  Table 2: Property Codes for Thermodynamic 
and Transport Properties of Steam (page 31) for a listing of 
valid property codes. 

units is an integer argument (optional in Excel). For Metric/SI 
units, specify a value of 0 (or leave empty in Excel). For 
English units, specify a value of 1. 

Remarks 
 The specified pressure unit must be in bar if units is 0; and must be in 

psia if units is 1. 
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 The pressure must be greater than or equal to the Triple Point Pressure 
(0.0061173 bar) and less than or equal to the Critical Pressure (220.55 
bar). 

 If any of the arguments are invalid or if the arguments are outside the 
acceptable bounds, the function returns the following error codes: 

 In Excel versions: #VALUE! error 

 In Lotus versions: ERR error 

Examples 
1. STPSAT(14.7,1,0,1) returns 212.02 which is the boiling point 

of water (in °F) at a pressure of 14.7 psia. 

2. STPSAT(14.7,1,8,1)-STPSAT(14.7,0,8,1) returns 
970.18 which is the enthalpy of vaporization (in Btu/lb) of water at a 
pressure of 14.7 psia. 

3. STPSAT(100,0,11) returns 6.124 which is the specific heat 
capacity at constant pressure (in kJ/(kg.°C)) at a pressure of 100 bar. 

STTSAT 
Calculates the saturated vapor, liquid or two-phase property at the specified 
temperature. 

Syntax 
STTSAT(temperature, quality, property_code, units) 

Arguments 
temperature is the temperature at which the saturated steam property is 

required. See the Remarks section for acceptable temperature 
units. 

quality is 1 for vapor phase properties, 0 for liquid phase properties 
and between 0 and 1 for two-phase. 

property_code is an integer property code that specifies the type of property 
required. See Table 2: Property Codes for Thermodynamic 
and Transport Properties of Steam (page 31) for a listing of 
valid property codes and their meaning. 

Units is an integer argument (optional in Excel). For Metric/SI 
units, specify a value of 0 (or leave empty in Excel). For 
English units, specify a value of 1. 

Remarks 
 The specified temperature unit must be in °C if units is 0; and must be in 

°F if units is 1. 



CHEMICALOGIC 

34  SteamTab V4.0 

 The specified temperature must be greater than or equal to the Triple 
Point Temperature (0.01°C) and less than or equal to the Critical 
Temperature (373.976°C). 

 If any of the arguments are invalid or if the arguments are outside the 
acceptable bounds, the function returns the following error codes: 

 In Excel versions: #VALUE! error 

 In Lotus versions: ERR error 

Examples 
1. STTSAT(212,1,1,1) returns 14.696 which is the vapor pressure 

(in psia) of water at a temperature of 212°F. 

2. STTSAT(212,1,8,1)-STTSAT(212,0,8,1) returns 
970.19 which is the enthalpy of vaporization (in Btu/lb) of water at a 
temperature of 212°F. 

3. STTSAT(300,0,11) returns 5.75 which is the specific heat 
capacity of liquid at constant pressure (in kJ/(kg.°C)) at a temperature of 
300°C. 

Functions for Superheated or Subcooled Steam Properties 
The functions in this category calculate the superheated vapor or subcooled 
liquid property at any two specified independent variables. These functions 
have a wide range of applicability. Generally, the properties returned by these 
functions are acceptable within the following ranges: 

 Pressure (P, bar):  0  P  100,000 

 Temperature (T, K): 190  T   5000 
 
The superheated/subcooled functions require two independent variables as 
input. Use the following table as a guide to select the appropriate function. 
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Specified Independent Variable  

First Variable Second Variable Use Function 

Temperature, T Pressure, P STTP 

Temperature, T Volume, V STTV 

Temperature, T Enthalpy, H STTH 

Temperature, T Entropy, S STTS 

Temperature, T Internal Energy, U STTU 

Pressure, P Volume, V STPV 

Pressure, P Enthalpy, H STPH 

Pressure, P Entropy, S STPS 

Pressure, P Internal Energy, U STPU 

 
All of these functions have a similar syntax and arguments as described 
below. 

General Description 

General Syntax 
STXX(first_variable, second_variable, property_code, units) 

Replace STXX with the appropriate function name . 

General Arguments 
first_variable is the first independent variable. 

second_variable is the second independent variable . 

property_code is an integer property code that specifies the type of property 
required. See Table 2: Property Codes for Thermodynamic 
and Transport Properties of Steam (page 31) for a listing of 
valid property codes and their meaning. 

Units is an integer argument (optional in Excel). For Metric/SI 
units, specify a value of 0 (or leave empty in Excel). For 
English units, specify a value of 1. 

General Remarks 
 If any of the arguments are invalid or if the arguments are outside the 

acceptable bounds, the function returns the following error codes: 
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 In Excel versions: #VALUE! error 

 In Lotus versions: ERR error 

 Some of these functions solve for the pressure iteratively. Therefore, it is 
possible that the function may fail to converge, in which case the 
function returns the above error codes. 

 
The individual functions are documented below. 

STTP 
Calculates superheated vapor or subcooled liquid property at the specified 
temperature and pressure.  

Syntax 
STTP(temperature, pressure, property_code, units) 

Remarks 
 The specified temperature unit must be in °C if units is 0; and must be in 

°F if units is 1. 

 The specified pressure unit must be in bar if units is 0; and must be in 
psia if units is 1. 

Examples 
1. STTP(500,200,12,1) returns 1810.1 which is the speed of 

sound in ft/s at a temperature of 500°F and a pressure of 200 psia. 

2. STTP(5000,1200,21,1) return 0.779 which is the Prandlt 
number at a temperature of 5000°F and a pressure of 1200 psia. 

STTV 
Calculates superheated vapor or subcooled liquid property at the specified 
temperature and volume. 

Syntax 
STTV(temperature, volume, property_code, units) 

Remarks 
 The specified temperature unit must be in °C if units is 0; and must be in 

°F if units is 1. 

 The specified volume unit must be in m3/kg if units is 0; and must be in 
ft3/lb if units is 1. 
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STTH 
Calculates superheated vapor or subcooled liquid property at the specified 
temperature and enthalpy. 

Syntax 
STTH(temperature, enthalpy, property_code, units) 

Remarks 
 The specified temperature unit must be in °C if units is 0; and must be in 

°F if units is 1. 

 The specified enthalpy unit must be in kJ/kg if units is 0; and must be in 
Btu/lb if units is 1. 

STTS 
Calculates superheated vapor or subcooled liquid property at the specified 
temperature and entropy. 

Syntax 
STTS(temperature, entropy, property_code, units) 

Remarks 
 The specified temperature unit must be in °C if units is 0; and must be in 

°F if units is 1. 

 The specified entropy unit must be in kJ/(kg.°C) if units is 0; and must be 
in Btu/(lb.°F) if units is 1. 

STTU 
Calculates superheated vapor or subcooled liquid property at the specified 
temperature and internal energy. 

Syntax 
STTU(temperature, internal_energy, property_code, units) 

Remarks 
 The specified temperature unit must be in °C if units is 0; and must be in 

°F if units is 1. 

 The specified internal energy unit must be in kJ/kg if units is 0; and must 
be in Btu/lb if units is 1. 
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STPV 
Calculates superheated vapor or subcooled liquid property at the specified 
pressure and volume. 

Syntax 
STPV(pressure, volume, property_code, units) 

Remarks 
 The specified pressure unit must be in bar if units is 0; and must be in 

psia if units is 1. 

 The specified volume unit must be in m3/kg if units is 0; and must be in 
ft3/lb if units is 1. 

STPH 
Calculates superheated vapor or subcooled liquid steam property at the 
specified pressure and enthalpy. 

Syntax 
STPH(pressure, enthalpy, property_code, units) 

Remarks 
 The specified pressure unit must be in bar if units is 0; and must be in 

psia if units is 1. 

 The specified enthalpy unit must be in kJ/kg if units is 0; and must be in 
Btu/lb if units is 1. 

STPS 
Calculates superheated vapor or subcooled liquid property at the specified 
pressure and entropy. 

Syntax 
STPS(pressure, entropy, property_code, units) 

Remarks 
 The specified pressure unit must be in bar if units is 0; and must be in 

psia if units is 1. 

 The specified entropy unit must be in kJ/(kg.ºC) if units is 0; and must be 
in Btu/(lb.ºF) if units is 1. 
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STPU 
Calculates superheated vapor or subcooled liquid property at the specified 
pressure and internal energy. 

Syntax 
STPU(pressure, internal_energy, property_code, units) 

Remarks 
 The specified pressure unit must be in bar if units is 0; and must be in 

psia if units is 1. 

 The specified internal energy unit must be in kJ/kg if units is 0; and must 
be in Btu/lb if units is 1. 

Functions for Constant Steam Properties 
The functions in this category return constant steam properties, such as, the 
molecular weight, critical properties, and triple point properties. 

The constant steam property functions are: 

Function Calculates Metric/SI 
Units 

English
Units

STMW Molecular weight kg/kmol lb/lbmol

STTC Critical temperature ºC ºF

STPC Critical pressure bar psia

STVC Critical specific volume m3/kg ft3/lb

STRC Critical specific density kg/m3 lb/ft3

STZC Critical compressibility factor dimensionless dimensionless

STTPT Triple point temperature ºC ºF

STTPP Triple point pressure bar psia

 
All of the functions in this category take an integer argument: units (optional 
in Excel) which is 0 or Metric units. For constant properties in English units 
set this argument to 1. 
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Note (Excel Only) 

If you want to use the default argument you need not specify 
any value. In this case, Excel users must use the “empty” 
parenthesis, for example, =STTC(). 

Examples 
1. STMW() returns 18.0152 which is the molecular weight of steam in 

kg/kmol 

2. STPC(1) returns 3198.8 which is the critical pressure of steam in 
psia 

3. STTPT(0) returns 0.01 which is the triple point temperature of 
steam in ºC 

 
 

en·tro·py 
en·tro·py noun 
plural en·tro·pies 
1. Symbol S. For a closed thermodynamic system, a quantitative measure of the 

amount of thermal energy not available to do work. 
2. A measure of the disorder or randomness in a closed system. 
3. A measure of the number of bits necessary to transmit a message as a function 

of the probability that the message will consist of a specific set of symbols. 
4. A hypothetical tendency for all matter and energy in the universe to evolve 

toward a state of inert uniformity. 
5. Inevitable and steady deterioration of a system or society.


